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1. Introduction
eProof files are self-contained PDF documents for viewing on-screen and for printing. They contain all appropriate formatting 
and fonts to ensure correct rendering on-screen and when printing hardcopy. DJS sends eProofs that can be viewed, annotat-
ed, and printed using the free version of Acrobat Reader 7 (or greater). These eProofs are “enabled” with commenting rights, 
therefore they can be modified by using special markup tools in Acrobat Reader that are not normally available unless using 
the Standard or Professional version.
The screen images in this document were captured on a PC running Adobe Acrobat Reader version 8.1.0. Though some of the 
images may differ in appearance from your platform/version, basic functionality remains similar. At the time of this writing, Ac-
robat Reader v8.1.0 is freely available and can be downloaded from: http://www.adobe.com/products/acrobat/readstep2.html

2. Comment & Markup toolbar functionality

	

	 A. Show the Comment & Markup toolbar	
	 The Comment & Markup toolbar doesn’t appear by default. Do one of 
	 the following:	
		  • Select View > Toolbars > Comment & Markup.
		  • Select Tools > Comment & Markup > Show Comment
		    & Markup Toolbar.
		  • Click the Review & Comment button in the Task toolbar, and choose
		     Show Comment & Markup Toolbar.
	 To add or remove tools for this toolbar, right-click the toolbar and select the tool. 
	 Or, select Tools > Customize Toolbars.
	
	 B. Select a commenting or markup tool
	 Do one of the following: 
		  • Select a tool from the Comment & Markup toolbar.
		  • Select Tools > Comment & Markup > [tool].
	 Note: After an initial comment is made, the tool changes back to the Select tool 
	 so that the comment can be moved, resized, or edited. (The Pencil, Highlight 
	 Text, and Line tools stay selected.)

	 C. Keep a commenting tool selected
	 Multiple comments can be added without reselecting the tool.
	 Select the tool to use (but don’t use it yet). 
		  • Select View > Toolbars > Properties Bar. 
		  • Select Keep Tool Selected. 
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4. Using the comment and markup tools
To insert, delete, or replace text, use the Text Edits tool. Select the Text Edits tool, then select the text with the cursor (or 
simply position it) and begin typing. A pop-up note will appear based upon the modification (e.g., inserted text, replacement text, 
etc.). Use the Properties bar to format text in pop-up notes. A pop-up note can be minimized by selecting the     button inside it.

3. The Properties bar
The Properties bar can be used to format text and select options for individual tools.
To view the Properties bar, do one of the following:
	 • Choose View > Toolbars > Properties Bar.
	 • Right-click the toolbar area; choose Properties Bar.
	 • Select [Ctrl-E]
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A. Attached file; B. Highlighted text; C. Crossed-out (strike-through) text; D. Inserted text; E. Replaced text
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7. Summary of main functions
Insert text - Use Text Edits tool (position cursor and begin typing)
Replace text - Use Text Edits tool (select text and begin typing)
Delete text - Use Text Edits tool (select text and press delete key)
Highlight text - Use Highlight Text tool (select text)
Attach a file - Use the Attach a File with Comment tool (select tool, position 
                      cursor and click mouse, select file)

Suggested toolbar layout

Use the Comments list to review all changes

8. Reviewing changes
To review all changes, do the following:	
		  • Select the Show button on the Comment & Markup toolbar.
		  • Select Show Comments List.
			   Note: Selecting a correction in the list will highlight the corresponding item in the document, and vice versa.

9. The eReturn process

	 A. An email is received that contains a link to the eProof of the article:
		  http://eproofing.dartmouthjournals.com/pdfproofing/journal1234.pdf
	 B. Click on the link to open the proof with the internet browser. Select “Save As” from the browser’s ‘File’ menu to save a 
		  copy of the PDF to the desktop or other folder.
	 C. Close the browser and open the saved PDF file with Acrobat.
	 D. Make corrections using Acrobat’s Comment & Markup tools.
	 E. Save the PDF file, now with annotations, and return according to the instructions provided by the DJS journal manager.

5. Inserting symbols or special characters
An ‘insert symbol’ feature is not available for annotations, and copying/pasting symbols or non-keyboard characters from Mi-
crosoft Word does not always work. Use angle brackets < > to indicate these special characters (e.g., <alpha>, <beta>).

6. Editing near watermarks and hyperlinked text
eProof documents often contain watermarks and/or hyperlinked text. Selecting characters near these items can be difficult us-
ing the mouse alone. To edit an eProof which contains text in these areas, do the following:	
		  • Without selecting the watermark or hyperlink, place the cursor near the area for editing.
		  • Use the arrow keys to move the cursor beside the text to be edited.
		  • Hold down the shift key while simultaneously using arrow keys to select the block of text, if necessary.
		  • Insert, replace, or delete text, as needed.
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     The parenchyma in the secondary xylem of woody plants has 
important functions for the metabolism and storage of reserve 
substances, as well as for defense against pathogens ( Sauter, 
1988 ;  Schmitt and Liese, 1990 ;  Carlquist, 2001 ). Various hy-
potheses about the role of the parenchyma in the hydraulic 
function of xylem have been suggested and discussed, in par-
ticular, in long-distance water transport and refi lling of embo-
lized conduits ( Braun, 1984 ;  Pate and Jeschke, 1995 ;  Salleo 
et al., 1996 ;  Holbrook and Zwieniecki, 1999 ;  Tyree et al., 1999 ; 
 De Boer and Volkov, 2003 ;  Hacke and Sperry, 2003 ;  Clearwater 
and Goldstein, 2005 ). The structure of xylem parenchyma 
greatly varies among species, and it has been classifi ed mor-
phologically ( Kribs, 1937 ; Metcalfe and Chalk, 1989;  IAWA, 
1989 ;  Carlquist, 2001 ). Disjunctive xylem parenchyma is one 
of the categories that to date has received little attention. 

 Parenchyma cells and tracheids with disjunctive cell walls 
occurring in association with large-diameter vessel elements 
have been mentioned in the literature since the 1930s ( Esau, 
1965b , p. 262;  Fahn, 1990 ). Currently, xylem (ray and axial) 
parenchyma with disjunctive cell walls is used as one of the 
characters in comparative wood anatomy, namely, feature num-
ber 113 in the International Association of Wood Anatomists 

(IAWA) list of microscopic features for hardwood identifi ca-
tion ( IAWA, 1989 ). On the basis of histological observations 
by light microscopy, disjunctive xylem parenchyma has been 
defi ned as axial or radial parenchyma cells partly becoming dis-
junct during the differentiation process but the contact between 
the cells is maintained through tubular connections ( Normand, 
1972 ;  IAWA, 1989 ). Although this defi nition describes the ap-
pearance of disjunctive cells, the occurrence of tubules and 
identifi cation of disjunctive cells is not easily discernible with a 
traditional light microscope, and available data about this wood 
anatomical character are scarce. To our knowledge, there are 
neither detailed studies nor clear illustrations of the morphol-
ogy of the disjunctive xylem parenchyma cells, and the mecha-
nism of formation of disjunctive walls is still a puzzling 
phenomenon in wood formation. Consequently, not only the 
structure but also the ontogeny and phylogeny of xylem with 
such characteristics have yet to be studied. 

 In temperate regions, disjunctive xylem parenchyma has 
been observed among ray cells in some species of the families 
Buxaceae, Cornaceae, Ericaceae, and Rosaceae ( Richter and 
Dallwitz, 2000 ) and among axial parenchyma in  Actinidia  sp. 
(P. Kitin and S. Noshiro, personal observations). The list of 
species with disjunctive parenchyma might be longer, but dis-
junctive cells in temperate woods are rarely reported, probably 
because this type of structure is not well known and the disjunc-
tions between the cells are typically small and diffi cult to no-
tice. By contrast, disjunctive parenchyma is a common feature 
in species of the  Sophora  group of the legumes (Fabaceae) ( Fujii 
et al. 1994 ) and is apparent in many tropical species ( Richter 
and Dallwitz, 2000 ; H. Beeckman and P. Kitin, personal obser-
vations). Axial parenchyma cells frequently have disjunctive 
walls in the stem wood of  Okoubaka aubrevillei  Pellegr. et Nor-
mand (Santalaceae), which we selected for investigation. 

  Okoubaka aubrevillei  is a fast-growing tree species from the 
rainforests of West and Central Africa ( Tailfer, 1989 ). Its wood 
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  WHAT IS DISJUNCTIVE XYLEM PARENCHYMA? A CASE STUDY OF 
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 The morphological variation and structure – function relationships of xylem parenchyma still remain open to discussion. We ana-
lyzed the three-dimensional structure of a poorly known type of xylem parenchyma with disjunctive walls in the tropical hardwood 
 Okoubaka aubrevillei  (Santalaceae). Disjunctive cells occurred among the apotracheal parenchyma cells and at connections be-
tween axial and ray parenchyma cells. The disjunctive cells were partly detached one from another, but their tubular structures 
connected them into a continuous network of axial and ray parenchyma. The connecting tubules had thick secondary walls and 
simple pits with plasmodesmata at the points where one cell contacted a tubule of another cell. The imperforate tracheary elements 
of the ground tissue were seven times longer than the axial parenchyma strands, a fact that supports a hypothesis that parenchyma 
cells develop disjunctive walls because they are pulled apart and partly separated during the intrusive growth of fi bers. We discuss 
unresolved details of the formation of disjunctive cell walls and the possible biomechanical advantage of the wood with disjunctive 
parenchyma: the proportion of tissue that improves mechanical strength is increased by the intrusive elongation of fi bers (thick-
walled tracheids), whereas the symplastic continuum of the parenchyma is maintained through formation of disjunctive cells. 

  Key words:  disjunctive cell wall;  Okoubaka aubrevillei ; Santalaceae; wood formation; wood structure; xylem parenchyma. 
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mounted with glycerol on microscope slides as described by  Kitin et al. (2004) . 
Incident-light from an argon ion laser (excitation, 488 nm) and long-pass fi lter 
(LP, 590 nm) or a helium neon laser (excitation, 543 nm; LP, 590 nm) were 
used for observations with a confocal microscope (LSM-310 [Carl Zeiss, 
Oberkochen, Germany] or C1 [Nikon Optics, Tokyo, Japan]). 

 Xylem anatomical features   —     Methods follow those of the IAWA (1989) 
Committee. Permanent microscope slides from the collection of the Royal Mu-
seum for Central Africa in Belgium were used for general description of the 
xylem anatomy. Tangential diameters of vessel lumina were measured in trans-
verse sections of xylem. In addition, macerated samples of xylem tissue were 
prepared from small wood blocks soaked in a mixture of equal volumes of gla-
cial acetic acid and 6% hydrogen peroxide and heated at 60 ° C for 1 or 2 days. 
The lengths of vessel elements and fi bers were measured on macerated samples 
( Kitin et al. 1999 ), and the lengths of axial parenchyma strands were measured 
in tangential sections on digital images that we analyzed with Image J software 
(available at http://rsb.info.nih.gov/ij; Wayne Rasband, National Institutes of 
Health, Bethesda, Maryland, USA). We compared lengths of vessel elements, 
fi bers, and axial parenchyma strands using independent sample  t  tests. 

 RESULTS AND DISCUSSION 

 Xylem structure   —      Views of transverse, radial, and tangential 
sections of the wood of  O. aubrevillei  are shown in  Figs. 1, 2, 
and 6 . The observed microscopic features according to the 
IAWA Hardwood Lists ( IAWA, 1989 ) were as follows: dif-
fuse-porous; exclusively solitary vessels with tangential diam-
eters of the lumina in the range of 150 – 200  μ m ( N  = 50), and 
simple perforation plates; fi bers thick-walled with distinctly 
bordered pits common in both radial and tangential walls (trac-
heids); rays 3 – 7 seriate. The horizontal diameters of ray cells in 
tangential section vary in the range of 20 – 60  μ m ( N  = 100) ( Fig. 
1C ).  Axial parenchyma patterns include scanty paratracheal 
and apotracheal-diffuse and diffuse-in-aggregates ( Fig. 1A ,  2 ).  
Axial strands most commonly contain 2 – 3 cells, but strands of 
more than 3 cells occur as well ( Fig. 1B, C ). The shape of the 
axial parenchyma cells in tangential sections is frequently ir-
regular rather than oval or tetra-angular (Fig. 1D). 

 The mean length of fi bers was 2010.44  ±  328  μ m, which was 
signifi cantly greater than the mean length of vessel elements 
(280.69  ±  41  μ m;  t  = 38.4955; df = 54;  P   <  0.001), or axial pa-
renchyma strands (291.42  ±  36  μ m;  t  = 38.3034; df = 54;  P   <  
0.001) (unequal variances were indicated by a preliminary  F -
test). The lengths of vessel elements and axial parenchyma 
strands are equivalent to the lengths of the initial cambial cells, 
which also differentiate into fi bers (for reviews, see  Larson, 
1994 ;  Kitin et al., 1999 ). Hence, it follows that during the xy-
lem ontogeny, the fi bers ’  length in  O. aubrevillei  increases 
about by a factor of 7 through intrusive growth. A sevenfold 
elongation ratio of fi bers to axial parenchyma during develop-
ment suggests considerable increase in the mass proportion of 
fi bers relative to that of axial parenchyma. 

 The morphological defi nition of fi bers with distinctly bor-
dered pits ( Baas, 1986 ;  IAWA, 1989 ) is broader and partly 
overlaps with the terms true tracheids and fi ber-tracheids used 

is straight-grained, heavy, and hard, with a basic density of 0.68 
g/cm 3  ( Bluskova et al., 1995 ). Anatomical descriptions of xy-
lem of this species have been reported by  Normand (1944 , 
 1950 ,  1972 ),  Lebacq and Dechamps (1964 ,  1967 ), and  
Normand and Paquis (1977) ; however, only  Normand (1972)  
noted the occurrence of disjunctive parenchyma. 

 In this study, our goal was to characterize the three-dimen-
sional (3D) morphology and arrangement of the xylem paren-
chyma of  O. aubrevillei . Our hope was to then use these analyses 
for clues to understanding the pattern of development of dis-
junctive cells and the factors triggering their formation. 

 MATERIALS AND METHODS 

 Plant materials   —     Wood blocks from six trees of  Okoubaka aubrevillei  Pel-
legr. et Normand were obtained from xylarium samples of the Royal Museum 
for Central Africa, Tervuren, Belgium (specimens: Tw 7135, Tw 7967, Tw 
8498, collected by R. Dechamps; Tw 5323, Tw 6577, Tw 21883, collected by 
Exforka [Exploitation foresti è re au Kasa ï ]). Only wood sample Tw 8498 has a 
detailed herbarium voucher; it was collected in Kasai Oriental (Bana-Longo), 
Democratic Republic of Congo (longitude 21 ° 30 ′ E, latitude 04 ° 48 ′ N, altitude 
535 m a.s.l.), in a table land forest. It was a large tree with buttresses (height 
20.4 m, main stem length 17 m, diameter 78 cm). The local names of the species 
are tsiluba, didwe, and mutshi ditoke. 

 Scanning electron microscopy (SEM)  —    Small blocks of wood from each of 
the six trees were cut to 7 mm (longitudinal direction)  ×  2 mm (radial)  ×  5 mm 
(tangential) or 7 mm (longitudinal direction)  ×  5 mm (radial)  ×  2 mm (tangen-
tial) and rinsed in water. The radial and the tangential surfaces were planed with 
a razor blade. Then the samples were processed for scanning electron micros-
copy (SEM) as described by  Ohtani et al. (1992)  and examined with a scanning 
electron microscope (JSM-35CFII, JEOL, Tokyo, Japan) at an accelerating 
voltage of 15 kV. 

 Conventional light microscopy and transmission electron microscopy 
(TEM)   —     Some of the wood samples were trimmed with a razor blade into 
small blocks with longitudinal and transverse sides of 4 – 5 mm and were treated 
with aqueous potassium permanganate or a 1% aqueous solution of osmium 
tetroxide for 1 h to stain cell walls and improve the contrast of TEM imaging of 
lignifi ed walls and remnants of membranes and protoplast. Next, the samples 
were embedded in Epon 812 (TAAB, Berkshire, UK). The epoxy-embedded 
samples were cut into serial, transverse, semithin (1 – 5  μ m) sections with an 
ultramicrotome (Ultracut; Reichert-Jung, Vienna, Austria) using a glass knife, 
and then stained with safranin in a 1% aqueous solution. After washing in wa-
ter, the sections were transferred onto microscope glass slides and air-dried. 
Finally, the sections were mounted with mounting medium (Bioleit; Oken-
shoji, Tokyo, Japan), and the microscope slides were observed with a conven-
tional and polarized-light microscope (BHS-751P; Olympus, Tokyo, Japan). 

 For observation of the ultrastructure of xylem parenchyma cell walls, 70-
nm-thick sections were cut with a diamond knife, then stained with uranyl ac-
etate and lead citrate, and examined with a transmission electron microscope 
(JEM-100C; JEOL, Tokyo, Japan) at an accelerating voltage of 100 kV 
( Watanabe et al. 2006 ). 

 Confocal laser scanning microscopy (CLSM)   —     Transverse and tangential 
sections of xylem (thickness, 20 – 40  μ m) were cut with a sliding microtome. 
The sections were stained with safranin as described by  Kitin et al. (2002 , 
 2003 ), cleared in xylene and mounted with Bioleit, or left without staining and 

¬
 Fig. 1.   Wood of  Okoubaka aubrevillei . (A) Bright-fi eld light micrograph (bf) of a general view of transverse section. (B) Longitudinal radial section 

(bf). C, D, and F. Longitudinal tangential sections (bf). (C) General view. (D) Enlarged view of disjunctive axial parenchyma cells (right) adjacent to a ray 
(left). Bar = 15  µ m. (E) SEM micrograph of a radial section. Tubular protuberances of disjunctive cells pass between fi bers. (F) Enlarged view of tubular 
connections between disjunctive axial parenchyma cells in tangential section (bf). Bar = 20  µ m. G, Axial parenchyma cells and fi bers in macerated xylem. 
Arrow points to tubular protuberances of an axial parenchyma cell. Bar = 40  µ m.  Abbreviations to all fi gures:  A, Axial parenchyma; CR, crystals; F, fi bers 
(tracheids); IF, included in rays fi bers; R, ray cells; SP, simple pits; T, tubular protuberances of disjunctive parenchyma cells; V, vessel elements.   
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 Fig. 2.   Selected bright-fi eld light micrographs of a series of cross sections of epoxy embedded wood of  Okoubaka aubrevillei . The vertical distance 
between each of the images from (A) through (C) is about 10  µ m. Identical disjunctive parenchyma cells are indicated by the same number. Arrows point 
to the site of tubular connections between disjunctive cells. Note the connections between cells (1 and 2), (3, 4, 5, 6, and 7), and (8, 9, and 10). Although 
the cells are classifi ed as  “ diffuse parenchyma ”  in single sections, along the vertical axis, they are interconnected through tubular protuberances.   

by  Carlquist (1985 ,  1986 ,  2001 ).  Carlquist (1985 ,  2001 ) defi nes 
the true tracheids as capable of water transport as a subsidiary 
conducting system when vessels become dysfunctional by em-
bolism, and the fi ber-tracheids as more specialized in mechani-
cal function. Sherwin Carlquist (Santa Barbara Botanic Garden, 
California, personal communication) stated that vasicentric tra-
cheids do occur in the Santalaceae. However, we found a single 
type of imperforate tracheary elements in  O. aubrevillei , which 
are classifi ed as ground tissue true tracheids sensu  Carlquist 
(2001) . It has to be noted, however, that the tracheids typically 
do not elongate much during xylem differentiation and are as-
sociated with comparatively long vessel elements ( Carlquist, 
1975 ,  1986 ;  IAWA, 1989 ). In contrast, the imperforate trache-
ary elements in  O. aubrevillei  are seven times longer than the 
vessel elements. They still fall in the category  “ tracheids ”  by 
 Carlquist (1975 ,  2001 ) who considers the nature of the pits and 
the conductive capabilities as the primary characteristics of de-
fi ning tracheids, whereas the cells can differ widely in length 
and wall thickness. The intrusive growth does not prevent for-
mation of bordered pit pairs in the walls of the pointed cell tips 
(note black arrows in  Fig. 6 ), which supports the assumption for 
a hydraulic function of these cells. 

 As discussed earlier, the imperforate tracheary elements in 
 O. aubrevillei  are thick-walled  “ fi bers with distinctly bordered 
pits in both tangential and radial walls ”  ( IAWA, 1989 ) or true 
tracheids sensu  Carlquist (2001) . The general term fi bers is 
commonly used for ground tissue, imperforate elements in 
hardwoods by botanists and foresters. For conciseness, further 
in the text, we shall call the imperforate tracheary elements in 
 O. aubrevillei  fi bers or thick-walled tracheids. 

 The majority of axial parenchyma cells appear partly de-
tached from each other with tubular protuberances that con-
nect to neighboring cells ( Fig. 1D, F ). This architecture is in 
accordance with  Normand (1972) , who fi rst defi ned the xylem 
parenchyma in this species as disjunctive. The tubular struc-
tures of the xylem parenchyma were easily seen in longitudi-
nal sections and in macerated wood ( Fig. 1D – G ). However, in 
transverse sections, the connecting tubules between adjacent 
cells were not always visible because of their positions at vari-
ous vertical levels ( Fig. 2 ). Three-dimensional analysis of the 

shape of axial parenchyma cells in a series of transverse sec-
tions of the wood blocks better demonstrated the presence of 
the tubules ( Fig. 2A – C ). The tubular formations were seen be-
tween adjacent fi bers (thick-walled tracheids) that separated 
the disjunctive apotracheal parenchyma cells (see arrows at 
identical cells in  Fig. 2A – C ). The tubular formations were also 
demonstrated in the stereographic images by SEM of longitu-
dinally sectioned wood blocks ( Fig. 1E ). The orientation of the 
tubular protuberances was predominantly in the radial direc-
tion, and they were easily detected in tangential longitudinal 
sections under the light microscope ( Fig. 1C, D, and F ), and by 
SEM ( Fig. 3 ).  However, the protuberances can be oriented in 
various directions, as seen in series of cross-sections ( Fig. 
2A – C ). The length of the tubules was variable, depending on 
the cell shape and the distance between the detached cells 
( Figs. 1F, 3 A, B). In some cells, we observed tubular exten-
sions of more than 20  μ m long, such as the extensions between 
cells 3 and 4, and 6 and 7 in  Fig. 2A – C . Transverse and longi-
tudinal sections of disjunctive axial parenchyma cells showed 
that the tubular extensions had thick secondary walls, which 
were birefringent in polarized light and were similar in thick-
ness to the walls of the body of the same cells ( Figs. 1G, 4 ).  
Simple to minutely bordered pit pairs with plasmodesmata 
were present at the ends of the tubular extensions where a tu-
bule of one cell contacted a tubule of another cell ( Figs. 3C, D, 
4B ). In addition, no apparent difference between the axial and 
ray parenchyma cells was detected regarding the structure of 
pits. In the walls of both types of cell, the pits had diameters of 
3 – 6  μ m, and plasmodesmatal channels were present in the pit 
membranes ( Fig. 5 ).  The plasmodesmatal interconnection be-
tween adjacent living parenchyma cells is a consistent feature 
of the secondary xylem (reviewed in  Barnett, 2006 ). In addi-
tion, bordered pits commonly occur in thick lignifi ed walls of 
ray and axial parenchyma in many species of woody dicotyle-
dons, which may be related to mechanical strength of the pa-
renchyma wall ( Carlquist, 2007 ). 

 In other tree species, disjunctive cells have been found pre-
dominantly in rays and rarely in axial parenchyma ( IAWA, 
1989 ;  Carlquist, 2001 ). However, in  O. aubrevillei  disjunc-
tive cells of the rays were not apparent and were observed 
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 Fig. 3.   SEM micrographs of xylem of  Okoubaka aubrevillei . (A) Tangential view of longitudinally sectioned disjunctive axial parenchyma cells. (B) 
Tubular protuberances of disjunctive axial parenchyma cells. Arrowheads point to the connection points between adjacent cells. (C) View from the lumen 
side of disjunctive parenchyma cells. Tubular protuberances with pits in the walls are seen from the lumen side. (D) View from the outer side of a disjunctive 
parenchyma cell. Tubular protuberances with pits at their tips are seen from the outside. The pit membranes are partly removed during sectioning.   

only in a few sections. Such cells frequently occurred between 
axial and ray parenchyma cells ( Figs. 2 and 5B ) and among 
the axial apotracheal and scanty paratracheal parenchyma 
( Figs. 2 and 6 ).  

 Pattern of formation of disjunctive parenchyma cells :  The 
 “ mechanistic ”  hypothesis   —      A  “ mechanistic ”  hypothesis has 
been proposed to explain the unusual appearance and origin of 
the disjunctive cells in xylem ( Esau, 1965a , see p. 47;  Normand, 
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 Fig. 4.   SEM micrographs of longitudinal sections of xylem showing disjunctive axial parenchyma cells of  Okoubaka aubrevillei . (A) Cross section 
through tubular protuberances. (B) Longitudinal section (LS) through tubular protuberances of adjacent disjunctive axial parenchyma cells. Simple or 
slightly bordered pits are seen at the contact points of the tubules of adjacent cells. Arrowheads point to intercellular spaces. (C) Enlarged view of the upper 
tubule in (A). (D) LS through tubular protuberance of disjunctive axial parenchyma cell. The secondary wall appears to have a multilayered structure (see 
also C). Scale bar in (B).   

1972 ;  Metcalfe and Chalk, 1989 ). Disjunctive wood elements 
have been assumed to form as a result of mechanical tensions 
and rearrangements of the wood tissue due to different rates of 
growth of various xylem cells during the process of xylem dif-
ferentiation. For example, some vasicentric tracheids or paren-
chyma cells have been assumed to become disjunctive through 
the pressure of the expanding vessel elements forcing adjacent 
cells apart. However,  Fujii et al. (1994)  found in the  Sophora  
group (Fabaceae) that disjunctive axial parenchyma cells were 
not always associated with vessel elements and that such cells 

can also occur in species with vessel elements of less than 100 
 μ m in diameter. Therefore, they suggested that formation of 
disjunctive cell walls of axial parenchyma cells may be induced 
mainly by the intrusive growth of fi bers. Such a mechanism 
could also be responsible for the formation of disjunctive cell 
walls of the apotracheal parenchyma in  O. aubrevillei , in that 
the disjunctive parenchyma of this species is mostly within the 
ground tissue of fi bers (thick-walled tracheids), which are seven 
times longer than the axial parenchyma strands/vessel elements. 
In other species, such as sessile oak ( Quercus petraea ), which 
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parenchyma and the considerable elongation rate of fi bers sug-
gest that the separation of adjacent parenchyma cell walls could 
result from an intensive intrusive growth of differentiating fi -
bers. In differentiating xylem, the middle lamella of axial pa-
renchyma cells is not lignifi ed and is probably not resistant to 
tensile forces. Mechanical forces induced by the intrusively 
growing tips of elongating fi bers could cause separation of the 
middle lamella and the disjunction of adjacent parenchyma 
cells. However, by some mechanism, owing to the extensibility 
of plasmalemma and cytoplasm, the plasmodesmata between 
adjacent cells are not disconnected, and the complete separation 
of disjunctive cell walls is prevented, sustaining the continuum 
of the symplast. 

 Xylem parenchyma cells form secondary walls later than 
their neighboring vessel elements ( Kitin et al. 2003 ). Because 
of this delay in differentiation, the primary walls of parenchyma 
cells could possibly be extended at the cell-to-cell symplast 
communication points that form the tubule-like structures. The 
deposition of a thick secondary wall in the tubular extensions, 
such as that seen in  Fig. 4 , could only occur after the elongation 
of fi bers has ceased. 

 Perspectives for further research on the mechanism of dis-
junctive cell wall development   —      Our results illustrated the 
three-dimensional shape of disjunctive cells and strongly sup-
ported the hypothesis for a cell – cell separation mechanism 
leading to disjunctive parenchyma. However, the mechanistic hy-
pothesis does not entirely explain the formation of disjunctive 

 Fig. 5.   Longitudinally sectioned xylem of  Okoubaka aubrevillei . (A) 
TEM micrograph showing a pit pair in the adjacent cell walls of xylem pa-
renchyma cells. Plasmodesmata are seen in the pit membrane. Bar = 1  µ m. 
(B) SEM micrograph showing a tangential view of disjunctive ray and axial 
xylem parenchyma cells. Horizontal arrow points to a pit pair between ray 
cells, and vertical arrow points to a blind pit to intercellular space.   

 Fig. 6.   Transverse section of wood of  Okoubaka aubrevillei , ~40  µ m 
thick, stained with safranin. Confocal microscopy image viewed with exci-
tation by a helium neon laser (543 nm) and a long-pass fi lter (590 nm). 
Arrowheads point to tubular protuberances of axial parenchyma cells. 
White arrows point to pits between axial parenchyma cells and adjacent 
fi bers (tracheids). Black arrows point to pit pairs connecting the intrusively 
grown tips of fi bers (cells with small diameters) with the central portion of 
adjacent fi bers (cells with larger diameters). Such pit connections have 
been additionally established between adjacent fi bers during the differen-
tiation of xylem. Scale bar = 30  µ m.   

lacks disjunctive apotracheal parenchyma, fi bers are only 2 – 3 
times longer than vessel elements ( Heli  ska-Raczkowska and 
Fabisiak, 1991 ). The mostly apotracheal arrangement of axial 
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narrow tangential bands ”  ( IAWA, 1989 ). Diffuse and diffuse-
in-aggregates are transitional arrangements because, as dis-
cussed by  Carlquist (2001, p. 161) ,  “ where diffuse axial 
parenchyma cells are more abundant, random distributions of 
axial parenchyma cells inevitably result in small groupings here 
and there. ”  According to the classifi cation scheme of Kribs 
(1937), the diffuse axial parenchyma is the most primitive type 
of arrangement and is associated with longer vessel elements. 
The  “ aggregated ”  type of parenchyma is usually present in 
more advanced woods, in combination with other specialized 
wood elements. Although, specialization trends and phylogeny 
of different types of parenchyma can be complex and disput-
able ( Baas, 1982 ; see also  Metcalfe and Chalk, 1989 , p. 117), 
aggregated types of parenchyma are commonly considered to 
perform more effi ciently their storing and conductive functions 
by better  “ bridging ”  between axial and radial parenchyma sys-
tems ( Carlquist, 2001 ). As shown in the scheme in  Fig. 7 ,  dif-
fuse parenchyma composed of disjunctive cells provides good 
bridging between the axial and radial systems of parenchyma 
and also can be considered effi cient for conductive function. 

 According to  Carlquist (2001) , diffuse parenchyma often oc-
curs in woods with tracheids and may represent a way of dis-
persing parenchyma among water-conducting cells. Similarly, 
the fi brous ground tissue of  O. aubrevillei  is composed of thick-
walled tracheids (fi bers with distinctly bordered pits in both 
radial and tangential walls), and pit contacts occur frequently 
between tracheids and disjunctive axial parenchyma (white ar-
rows in  Fig. 6 ). Such pit pairs between axial parenchyma and 
fi bers (thick-walled tracheids) may have a hydraulic function, 
but we know little about this yet. 

 The phylogeny of xylem with disjunctive parenchyma might 
indicate parallel evolution of the fi brous and parenchymatic xy-
lem tissues. A higher rate of xylem fi ber elongation leads to a 
greater proportion of specialized mechanical elements, which, in a 
species such as  O. aubrevillei , are accompanied by disjunctive 

cell walls, and several questions regarding the development 
of tubular contacts are still unanswered. That only certain por-
tions of the double cell walls of xylem parenchyma can be sepa-
rated might be related to a heterogeneity in the structure of 
primary walls. Several studies of different species have shown 
that the cell wall is thinner at the primary pit fi elds, and the 
orientation of microtubules at the pit membranes differs from 
the adjacent primary wall areas ( Barnett and Harris, 1975 ;  Abe 
et al., 1997 ;  Funada et al., 2001; Kitin et al., 2001 ). Primary pit 
fi elds, which are rich in plasmodesmata and distinct in struc-
ture, may behave differently than other areas of the cell wall. 
Earlier studies by  Wenham and Cusick (1975) ,  Barnett and 
Harris (1975) ,  Barnett (1981) , and  Catesson et al. (1994)  have 
shown dynamic changes in the structure of the middle lamella 
during differentiation of xylem cells. Those earlier studies on 
xylem formation suggest that investigating the ultrastructure of 
the middle lamella and the plasmodesmata-containing primary 
walls of developing parenchyma cells in  O. aubrevillei  could 
elucidate the mechanism that allows symplast extension and 
prevents the complete separation of cells. Furthermore, the xy-
lem with disjunctive parenchyma may be an interesting model 
for studying the mechanisms of growth of xylem cells and the 
plasticity of the primary wall. 

 Whereas dried wood samples were suffi cient for our purpose 
of studying the morphology of disjunctive xylem parenchyma, 
the detailed understanding of the process of disjunctive wall 
formation would require the study of differentiating xylem. 

 What are the consequences of the structural difference be-
tween wood with and without disjunctive parenchyma?   —      The 
mechanistic hypothesis explains the origin of disjunctive paren-
chyma as being the result of mechanical forces of cell readjust-
ments during xylem development. In addition to the mechanics 
of wood formation there could be a physiological strategy of 
the species to develop disjunctive parenchyma. 

 A systematic investigation of the wood structure of Central 
African trees found that disjunctive xylem parenchyma is com-
mon in many tropical species and different taxonomic groups 
(H. Beeckman and P. Kitin, unpublished results). It is not 
known why disjunctive xylem parenchyma is more frequent (or 
better developed) in the tropics than in the temperate zones. 
Similarly, xylem parenchyma in general tends to be more abun-
dant in tropical than in temperate species, but the reason is un-
clear ( Baas, 1982 ;  Wheeler and Baas, 1991 ;  Alves and 
Angyalossy-Alfonso, 2002 ). While this is still an open discus-
sion, a higher proportion of parenchyma probably points toward 
the evolution to higher complexity and more pronounced spe-
cialization in tropical woods. Many of the resource levels in the 
tropical rainforests are constantly abundant (high temperatures, 
high precipitation). There is a year-round input of high quality 
energy from the sun. Severe interspecies competition also en-
hances the level of complexity; the number of species and their 
internal organization are much higher. Much more variation in 
growth forms and xylem structure is seen in the tropics: a higher 
proportion and diversity of parenchyma, disjunctive paren-
chyma, secretory tissues, septate fi bers, larger differences in the 
lengths between vessel elements and fi bers, and sometimes 
 “ anomalous ”  xylem structure such as included phloem. Most of 
these interesting phenomena in tropical woods still need 
ecophysiological explanations. 

 The 3D architecture of the disjunctive parenchyma in  O. au-
brevillei  shows that these types of cells combine features of the 
parenchyma defi ned as  “ diffuse ”  and defi ned as  “ apotracheal in 

 Fig. 7.   Schematic representation of the network of parenchyma cells 
in wood of  Okoubaka aubrevillei . The disjunctive axial parenchyma cells 
(dap) are connected through tubular protuberances with each other and 
with the parenchyma of rays (ray). The tubular protuberances pass between 
intrusively elongated fi bers (f). Each living parenchyma cell (dap and ray) 
is part of a common symplast of the xylem. Note that in reality the mean 
length of fi bers is about seven times greater than that of axial parenchyma 
strands. Also for simplicity, vessels are not represented in the scheme.   
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parenchyma. The resulting structure may promote the mechani-
cal and the conductive (or storing) functions of wood: the pro-
portion of thick-walled tracheids (mechanical and water 
conductive/storing function) is increased without compromis-
ing the functionality of parenchyma because the number of 
cells and the connection between living protoplasts are main-
tained through tubular protuberances. The multilayered and lig-
nifi ed walls with minutely bordered pits of the parenchyma 
cells may additionally contribute to the mechanical strength of 
the wood. Maintaining the connections of parenchyma cells 
into a dense network may have a damper (shock-absorber) ef-
fect on mechanical stresses in analogy to what has been reported 
about the performance of bamboo ground parenchyma (Obataya 
et al., 2007). 

 A variety of biomechanical designs of xylem structure cor-
responding to diverse habitats coexist in nature (reviews in 
 Gartner, 2001 ;  Woodrum et al., 2003 ;  Rowe and Speck, 2005 ; 
 Read and Stokes, 2006 ). As mentioned earlier,  O. aubrevillei  is 
a large, fast-growing tree, with a comparatively high wood spe-
cifi c gravity. Its xylem structure, with a high elongation rate of 
fi bers (thick-walled tracheids) and the formation of disjunctive 
parenchyma, could be an interesting example of how plants 
deal with the tradeoffs between mechanical and conductive/
storing functions of xylem. 

 This three-dimensional study of the shape and spatial arrange-
ment of disjunctive xylem parenchyma in  O. aubrevillei  provides 
new insights on the variation and complexity of xylem structure. 
However, interesting questions on the mechanisms of formation 
of disjunctive cells as well as on their role in the xylem function 
remain to be answered. Further research on the differentiation 
process and the biomechanics of wood with disjunctive paren-
chyma is desirable for further understanding of the disjunctive 
xylem cell phenomenon and its biological signifi cance. 
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